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Before you begin… 
A few changes to the installation process and the minimum system requirements have occurred. 

 

• Access databases are no longer supported. If you are installing a Microsoft® SQL Server®, you 
will want to do so before installing TAB FusionRMS.  

• Microsoft® SQL Server® software and licensing is NOT INCLUDED and must be purchased 
separately. 

• Win2PDF printer software and licensing is NOT INCLUDED and must be purchased separately.  
• Microsoft® SQL Server® Express Edition software and licensing is NOT INCLUDED but can 

currently be downloaded from Microsoft® at no fee. Full Text Search requires the Advanced 
Edition of SQL Express.  

• A Database Administrator is required to configure and maintain the Microsoft® SQL Server® 
installation. Microsoft® SQL Server® must be installed and operational before TAB FusionRMS 
installation and training. 

• Before installing, you will want to make sure that the server and workstations have the 
supported versions of Microsoft® .NET Framework installed. Depending on the operating 
systems and network traffic, this can take a considerable amount of time. Please note that the 
upgrade to Microsoft® .NET Framework will require a reboot, which will affect user access to 
the server. Consider scheduling this upgrade for a time that will not impact users. 

• Review the minimum system requirements to ensure support compatibility. 
 

Upgrade Information 
If you are upgrading from a previous version, please review the following information: 

 
• TAB FusionRMS 10.0 will upgrade systems from 9.2 and above. 
• Once the installation has been started and the progress bar appears, old files will be 

removed. In order to use TAB FusionRMS, you must continue with the upgrade once 
it has begun. If you cancel before the installation is complete, you will not be able to 
use the application without uninstalling manually. 

 
 

Components 
The following is a list of the components that can be installed through the installer: 

 
• License Server: This is a required component on a network server. It is used to 

connect a database in the SLIM Manager or Database Utility with the Microsoft® 
SQL Server®. It also handles the synchronization of the Active Directory groups.  
It should only be installed in one location. 

• Service Manager: This handles retention-related reporting as a service. It is not 
required and can be installed at any time.  It should only be installed in one 
location. 
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• License Manager: The SLIM Manager provides the TAB FusionRMS administrator an 
interface to add or modify databases, licenses, and seat counts. It can be installed 
anywhere the administrator needs it, but it should only be installed in one location. 

• Image Service: Controls access to the image repository for the retrieval of images 
and documents for the TAB FusionRMS Attachment Viewer and Orphan Viewer as 
a Web Service. For imaging customers only. 

• Image Server Web Service: Manages attachments and documents within IIS for 
FusionRMS Web Access.  If you will be using FusionRMS Web Access Attachment 
Viewer, select this service instead of the Tab Image Service.  For imaging customers 
only. 

• TAB FusionRMS: The complete application, including the user interface and 
the Admin Manager. 

• File Tracking: A standalone application for use with a bar code reader. It can be 
installed with or without the complete application. 

• Past Due Email Utility:  A utility for sending out past due e-mail notifications. 
• Database Utility: An optional utility for adding databases to Microsoft® SQL Server® 

and SLIM Manager. This was designed to assist with connecting the sample database 
to a local installation of Microsoft® SQL Server® Express 2008 with Advanced Services. 

 
 

Installation 
 

STEP 1: Microsoft® SQL Server® Express with Advanced Services (if applicable) 
If a version of Microsoft® SQL Server® is not installed on your computer, you can install a free version of 
Microsoft® SQL Server® Express. Installation times vary depending on your operating system and your 
version of .NET Framework. 

 
If you have already installed Microsoft® SQL Server® Express prior to this installation, see Known Issues at 
the end of this document. 

 
It is recommended that you install Microsoft® SQL Server® while logged in as the computer 
administrator.  

Close all other applications before installing. 
 

If you are installing on Windows Server 2008, you must enable the PowerShell feature. For more 
information on Windows PowerShell, please visit Microsoft®’s Website. 

If you are installing on Windows 7 and Windows Server 2008, you will encounter a program 
compatibility message concerning Service Pack 1. Click Run Program. Service Pack 1 will be 
automatically installed once the SQL installation is complete. 

1. Download and install Microsoft® SQL Server® Express Advanced Edition from Microsoft®. 
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2. Follow Microsoft®’s instructions to install Microsoft® SQL Server® Express Advanced 
Edition. Note:  You must right-click the file, and select Run as Administrator. 

3. A list will indicate what components are required.  Click Install. 
4. The application will begin installing.  Your computer may reboot during this process. 

Note: After the reboot, you may not see any indication that the installation is continuing.  In the 
lower-right corner of your screen, look for an icon concerning applications that need approval to 
continue at startup. Open this dialog, and then select the setup.exe file to allow the operation to 
continue. 

During the Microsoft® SQL Server® Express installation, create a default user name (sa) and password 
(1password$). If this installation of Microsoft® SQL Server® is to be used in production, it is 
recommended that you change the password to secure access to the database. 

Microsoft® SQL Server® Express 2will install as a named instance even with the default instance 
selected. This could cause connection problems with the SLIM Manager. As a workaround you can 
select the option to install a named instance and enter "MSSQLSERVER" as the instance name. 

STEP 2:  TAB FusionRMS Application 
1. Open the install folder. 
2. Double-click the Setup file. 
3. The Welcome screen appears.  Accept the license agreement by clicking Agree. 
4. License Server Location. If you know where the license server has been installed, enter the IP 

address and port number. Double-check your entry to make sure you’ve entered the correct 
information. If you do not know the location, you can search the network (Note: This may take 
several minutes, especially if the license server is not running on the network.) Or, if this is a 
server, you can skip this step and it will be installed as a component, or, if this is a workstation, 
you can skip this step and it will not be installed. 

5. Select your installation type. 
• Workstation: This is for the general end user. Does not include server components or 

sample databases. 
• Server: This is for a network server. It will include the License Manager, Service Manager, 

Image Server Web Service, and License Server. The License Manager (SLIM Manager) does 
not need to be installed on the server. It can be installed on the TAB FusionRMS 
administrator’s computer for easier access. 

• Server Workstation: Clients without large networks may install all of the server and 
workstation components on one computer that acts as the server. Users would need access 
to this computer to open a database. 

• Custom:  All components, except the Image Server Web Service and Database Utility. 
• Sales Demo:  All components, except the Image Server Web Service. 

6. Review and revise the list of components selected for install. In most cases the list will not need 
to be revised. 
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Note: Selecting an installation type will pre-select the list of components that are needed for 
that type of installation. 

7. Select a new destination folder for the selected components, or click Next to accept the default 
location. 

8. If installing the License Server, find and select your license file. (It can be entered later in the 
SLIM Manager.) Click Next to continue. 

9. For the services you will be installing, enter valid ports for each one. The default values are 
already present. Make note of these ports for future reference during installations. Click Next 
to continue. 

10. Click Install. 
11. Sales Demo/Database Utility ONLY:  Once the installation is finished, the Database Utility can 

be launched automatically.  If you have installed Microsoft® SQL Server® Express 2008 before 
installation, this utility will create a SQL database and connect it to the SLIM Server 
automatically. Click Add to begin this process. The sample database will be added to the 
Microsoft® SQL Server® and the SLIM Manager, TAB FusionRMS will launch, and the database 
will appear on the log in screen. Enter the user name administrator and the password 
password$ to gain access. 

 
 

Database Utility 
This is an optional utility for adding databases to a local Microsoft® SQL Server® and connecting them 
with SLIM. If your database is already on Microsoft® SQL Server®, you can use the Existing Database 
feature in Database Utility to connect the database to SLIM. 

ADVANCED USERS:  This utility can be used to build and attach a database file, restore a database 
backup file, or execute a SQL script on a local or network server. Use the Browse button to locate your 
file.  Enter your server name\SQL instance.  To populate the list with network servers, on the Tools 
menu, click Options, and then select Show Network Servers. Enter your authentication credentials (see 
below). Enter a Display Name. (This is the name you will see on the Log in screen database list.) You can 
use the Display Name to name the SQL database, or you can enter a unique database name. Click Add. 
These advanced features are not intended to be a substitute for Microsoft® SQL Server® Management 
Studio. 

 
 

One-Time Database Connection Credentials 
The credentials entered at the time of database connection are what the SLIM Server uses to create or 
communicate with the TAB FusionRMS database on Microsoft® SQL Server® without Active Directory 
Integration. 

 

With Windows Authentication: 
 

This simple process only requires that the user logged into the computer running the 
connection process have administrative rights to the Microsoft® SQL Server® and the 
Active Directory groups. 
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• In the SLIM Manager, leave the fields blank. 
 

• In the Database Utility, select Windows under Authentication. 

With SQL Authentication: 
 

This process requires that you enter a Login with the correct permissions created within 
Microsoft® SQL Server®. 

• In Microsoft® SQL Server®, create a Login with Microsoft® SQL Server® 
authentication selected. 

• For the default database, select the TAB FusionRMS database you will be 
connecting. (If you are using the Database Utility, leave the default value 
master.) 

• Under Server Roles, select sysadmin. 
• Under User Mapping, select the TAB FusionRMS database, and then grant 

the following memberships: db_datareader, db_datawriter, and 
db_owner.  (Skip this step if you are using the Database Utility.) 

In the SLIM Manager, enter the Login. In Database Utility, select SQL and then enter 
the Login. 

 
 

Database Connection Credentials for Initial Connection and Subsequent 
Active Directory Synchronization 
The SLIM Server handles the automatic synchronization process of the Active Directory groups and must 
have access to both the Active Directory system and the database on the Microsoft® SQL Server® 
through either a fixed Windows Authentication or a fixed SQL Authentication Login user. (Note: The 
Windows Authentication method is recommended since it will handle any password changes that may 
occur; however, the authentication on the SLIM Server will still need to be changed manually. The SQL 
Authentication behaves in the same manner as the Windows Authentication, but any password changes 
will need to be updated at all levels.) 

 
With Windows Authentication (recommended): 

 
This process begins with the initial database connection and continues repeatedly at a set interval or by 
the administrator to update the Active Directory Integration. (For information on manual and automatic 
synchronization, see the Synchronization: Manual and Automatic section below.) A fixed login/user will 
need to be created in Active Directory, Microsoft® SQL Server®, and then entered as a user for the SLIM 
Server service. 

First, create a user in Active Directory with rights to Active Directory, Microsoft® SQL Server®, 
and the SLIM Server service . 

 
Second, in Microsoft® SQL Server®, create a Login with Windows Authentication for this user. 

 
• For the default database, select the TAB FusionRMS database you will be 
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connecting.  (If you are using the Database Utility, leave the default value master.) 

• Under Server Roles, select sysadmin. 
• Under User Mapping, select the TAB FusionRMS database, and then grant the 

following memberships: db_datareader, db_datawriter, and db_owner. (Skip this 
step if you are using the Database Utility.) 

Third, add this user to the SLIM Server service. In Services, locate the SLIM Server. Right-click 
the service, and then click Properties. On the Log On tab, select This account, and then enter 
the user. 

 

With SQL Authentication: 
 

This process begins with the initial database connection and continues repeatedly at a set interval or by 
the administrator to update the Active Directory Integration. (For information on manual and automatic 
synchronization, see the Synchronization: Manual and Automatic section below.) A fixed login/user will 
need to be created in Active Directory, Microsoft® SQL Server®, and then entered as a user for the SLIM 
Server service. 

First, create a user in Active Directory with rights to Active Directory, Microsoft® SQL Server®, 
and the SLIM Server service . 

Second, in Microsoft® SQL Server®, create a Login with Microsoft® SQL Server® Authentication 
that shares the same user name and password that was created for Active Directory. 

• For the default database, select the TAB FusionRMS database you will be 
connecting.  (If you are using the Database Utility, leave the default value master.) 

• Under Server Roles, select sysadmin. 
• Under User Mapping, select the TAB FusionRMS database, and then grant the 

following memberships: db_datareader, db_datawriter, and db_owner. (Skip this 
step if you are using the Database Utility.) 

Third, add this user to the SLIM Server service. In Services, locate the SLIM Server. Right-click 
the service, and then click Properties. On the Log On tab, select This account, and then enter 
the user. 

 
 

TAB FusionRMS License Manager (SLIM Manager) and Database 
Connection 
All databases will need to be added to the License Manager (SLIM) before they can be opened in the 
TAB FusionRMS application. 

 
1. To open SLIM Manager 

• On the Start menu, point to All Programs, point to TAB FusionRMS, and click SLIM 
Manager. 

2. View and select options using the SLIM Server Manager tabs 
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a. License 
• View Registration and Dealer information 
• View Products, Seats, Features, and Details available with the current license. 
• To change or add a license 

• On the Action menu, click Acquire From Internet. 
• To change or add a license without access to the internet 

1. On the Action menu, click Load From File…. 
2. Locate the License Manager File by browsing to the Extras folder on the 

installation CD. 
• Note: If you do not have an installation CD and have received the License 

Manage File by some other means, copy the file into a network share or 
local folder, and then browse to it in order to select it. 

• To reset the license to Demonstration mode, do one of the following: 
• On the Action menu, click Reset Demo License. 

b. Databases 
• To add a database 

1. On the Action menu, click Add Database. 
2. Enter the database and server information.  (If you are using SQL 

Authentication, enter the user name and password for that log in. If you are 
using Windows Authentication, you must have already signed into the computer 
running the SLIM Manager as an administrator with rights to the Microsoft® SQL 
Server®; leave the fields blank.  See above sections on database connection 
credentials for more information.) 

3. Select Service Control Manager in order for retention-related reporting, such as 
the Inactive Records report and Eligible for Destruction report, to be handled as 
a service. 

4. Click OK. 
Note:  Do not add the same database twice. 

• To setup access to the database for TAB FusionRMS and Active Directory 
1. From the column on the left, click the + button, and then select the database. 
2. Enable Active Directory. 

c. Current User Seats 
• View Product, Host, and Time details of logged on users. 
• To reserve a seat for a user 

1. Click Current User Seats. 
2. On the Action menu, click Manage Seat Reservations. 
3. Select Manual Add. 
4. Enter a user name. 
5. Click the arrow on the right and select the product you would like to associate 

with the reserved seat. 
6. Click Add. 
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7. Continue to add reserved seats for users as necessary. Keep in mind that only 
one seat may be reserved for a user for each installed application. Also, the 
number of available seats in the pool for each installed application will be 
reduced by one for each reserved seat added. 

3. Close or refresh the License Manager (SLIM) to enable new or modified settings. 
• On the File menu, click Exit or Refresh. 

 

Database Conversion 
The first time the database is opened after an upgrade, you may see a message about updating your 
database to the current version. During this process, a new user is created with the user name 
administrator and the password password$. You can use this account to open TAB FusionRMS and 
complete any necessary tasks, but it is recommended that you change this password as soon as possible. 

 
 

Active Directory Integration 
TAB FusionRMS users and groups can be synchronized with the users of Active Directory. This feature 
helps administrators with tedious tasks, such as adding large numbers of users, updating e-mail 
addresses, and disabling user access. 

When you perform the integration, you will map all of the Active Directory groups with the groups you 
create in TAB FusionRMS. When you perform the synchronization, the mapped groups and all user 
information is brought over to the TAB FusionRMS system. When users log in, they use the same user 
name, password, and domain name that they would use to log in to their system. TAB FusionRMS will 
then authenticate this information through Active Directory. If the log in fails, TAB FusionRMS will then 
attempt to authenticate this information using the TAB FusionRMS information created during 
synchronization. 

The synchronization can be performed manually or scheduled to run automatically. When Active 
Directory synchronization occurs, only the TAB FusionRMS data is changed. Active Directory data is 
never altered—it is only queried. This means that if you need to add a user, first add the user in your 
Active Directory system and then perform a synchronization with TAB FusionRMS. User information 
should not be added or edited in the TAB FusionRMS system; it will not be passed back to Active 
Directory. 

Before you integrate with Active Directory you will need to set up your TAB FusionRMS groups and set 
the permissions. 

If you enable the Active Directory integration, you must map and synchronize the Administrator group to 
ensure access to all areas of the system. 

To integrate (or map) and synchronize your Active Directory groups with TAB FusionRMS groups 
 

1. Open the SLIM Manager. 
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2. Click the + button next to Databases. 
3. Select your database from the list. 
4. Select Enable. 
5. If found, your Active Directory domain, organizational units, and AD groups will load. If the 

wrong domain has been found, enter a new one. 
6. Select your organizational unit. 
7. Select your Active Directory group. 
8. Select the corresponding TAB FusionRMS group. 
9. Click Map selected groups. 
10. Continue to map your Active Directory groups and corresponding TAB FusionRMS groups. 
11. If you make a mistake, select the item from the synchronization map, and then click Delete 

Mapping. 
12. If you would like to create temporary tracking users if one does not exist in the tracking table, 

select Create tracking employee. You can then select whether this should occur for all groups 
or a selected AD group.  This is a temporary entry that is created for the session at log in. 

13. When you are finished, click Synchronize. 
 

Active Directory with the FusionRMS Web Access Module (Web Access) 
In order to use the Active Directory settings with Web Access, you will need to make the following 
setting changes where the database is published. 

Internet Information Services (IIS) setting 
 

1. On the Start menu, point to Administrative Tools, and then click Internet 
Information Services. 

2. Under Web Sites, right-click Default Web Site, and then click Properties. 
3. Select the Directory Security tab. 
4. Under Authentication and access control, click Edit. 
5. If selected, clear the Enable anonymous access. 

 
 

Synchronization:  Manual and Automatic 
If you need to force a synchronization because of important changes to your Active Directory system, 
you can open the SLIM Manager, select your database, and then click Synchronize. Otherwise, the 
synchronization will occur automatically every 30 minutes by default. 

ADVANCED: The synchronization time can be edited. In the Program Files > TAB > SLIM Server folder, 
open the slimService.exe.config file. The file will open in Microsoft® Visual Studio Tools. Locate the  line 
<add key="SynchronizationInterval" value="30" />.  Edit the number in minutes.  Save and close. 

 
• 0 (zero) means that the synchronization as a service will never run. All syncs will need to be 

performed manually in the SLIM Manager. 
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• It is recommended that you allow at least five minutes per database when setting the 
number of minutes. Generally, the synchronization completes in just a few seconds or less, 
but depending on the amount of server traffic, you should allow adequate time for the 
process to complete. 

 
 

Image Repository 
The service responsible for managing the image repository will need read/write permissions. When 
hosting the service in IIS, the ASP.NET account will need permission. When running as a Windows 
Service, the system account will need permission. 

 
 

Image Service File Type Exclusions 
Each service has a config file containing a list of file types that are not processed for pages or a preview 
image.  The list is stored in Tab.RecordsManagement.Imaging.Export.dll.config.  For the Web Service, 
the config file is located in [Install Directory]\ImageServer\Bin. For the Windows Service, the config file 
is located in [Install Directory]\Image Service. In both cases, the list is stored in the 
configuration\applicationSettings\Tab.RecordsManagement.Imaging.Export.MySettings\setting[name 
=’Exclusions’]\value section as a comma delimited list. Files of these types can still be used as an 
attachment and opened in the native application; however, they will not have a preview. 

 
 

SQL Database Backup 
The need to back up databases on a regular basis is a major component of managing any production 
system. Members of the Admin group can access a basic built-in backup utility to handle making a full 
copy of a database without having to use Microsoft® SQL Server® Management Studio. Note: This is a 
manual process and can be performed at any time. If you need more advanced backup options, use 
Microsoft® SQL Server® Management Studio to set functions such as performing differential backups or 
scheduling regular backups. 

 
To back up a database 

 
1. In TAB FusionRMS, on the Tools menu, click Admin Manager. 
2. In the Admin Manager, on the Tools menu, click Database Backup Wizard. 
3. Follow the on-screen instructions. 

 
 

Program Maintenance 
Once you have installed the TAB FusionRMS application and re-run the setup to add or remove extra 
components, it’s important to understand the Custom Setup options. Once past the Welcome screen, 
select Modify. On the Custom Setup screen, you can select the components you would like to upgrade 
and/or install. 
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• The components listed with the computer image next to them were found on 
your local machine and will be upgraded. 

• The components listed with the red X were not found on your local machine. No 
action is required. 

• If you select one of the components installed locally and switch it to the red X, that 
component will be removed completely from your local machine. 

• If you select one of the components with the red X and switch it to the computer 
image, it will be installed. 

 
 

Known Issues 
Upgrades and Microsoft® Connectivity icons:  TAB FusionRMS icons previously used to send documents 
to TAB FusionRMS may still appear on the toolbar of the connected applications. These can be removed 
by accessing the customization menu for each application and deleting them from the menu or toolbar. 
(JIRA SME-52) 

Unable to Connect to License Server: If you are having trouble connecting to the License Server at the 
time of log in, you may need to adjust your firewall settings. This issue was seen on systems running the 
server components on Windows Server 2003. 

1. First, on your server in your Windows Firewall Settings, add slimService.exe in the SLIM Server 
folder to the list of Exceptions. 

2. Second, if you are still experiencing the connection error, at each computer using TAB 
FusionRMS, add TabFusion.exe in the TAB folder to the list of Exceptions. 

Microsoft® SQL Server® Express: If you have already installed Microsoft® SQL Server® Express prior to 
this installation, the default settings for the TCP/IP and Named Pipes are disabled. These will need to be 
enabled in order for the Database Utility or the SLIM Manager to connect to the server. 

 
To enable TCP/IP and Named Pipes 

 
1. On the Start menu, right-click Computer, and then click Manage. 
2. Open Services and Applications. 
3. Open Microsoft® SQL Server® Configuration Manager. 
4. Open Microsoft® SQL Server® Network Configuration. 
5. Select Protocols for [SQLServerInstanceName]. 
6. Right-click both TCP/IP and Named Pipes and click Enable. 
7. Stop and start the Microsoft® SQL Server® service located in the Administrative 

Tools > Services > Microsoft® SQL Server® (SQLServerInstanceName). 
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Troubleshooting TAB FusionRMS 
 

Full Text Search: If no results are returned with a search or an error appears, you may need to set the 
FDHOST Launcher (MSSLFDLauncher) Service Account for full-text search capabilities in the 
Microsoft® SQL Server® Configuration Manager. 

Invalid column name error: Care should be taken by database administrators when manually removing 
a column from the database. This error is received when searching within a view that maps to a column 
which does not exist.  The problem can be corrected by removing the reference to the missing column 
or by creating the column.  (JIRA SME-3511) 

 
 

Troubleshooting Attachments 
 

500.0 Error:  If you receive a 500 error, uninstall and then reinstall the web service. 
 

404.3 Error: WCF needs to be registered. A batch file is available in the Extra folder > 
ImageServerWebService.  Right-click the file and select Run as administrator. 
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